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Notices

This user manual is intended for administrators and users of the PiXORD PD614 Series
Network Camera, including instructions for using and managing the camera on your network.
The use of surveillance devices may be prohibited by law in your country. It is the user’s
responsibility to ensure that the operation of such devices is legal before installing this unit for

its intended use.

Before the Network Camera is installed, all the safety and operating instructions should be
carefully read and followed to avoid damage due to faulty assembly and installation. This also

ensures the product is used properly as intended.

Heed all warnings
» Do not drop or strike this equipment
Sensitive electronics inside the camera are vulnerable to excessive strike.
» Do notinstall the equipment near any flames or heat sources
Excessive heat could damage this equipment.
» Do not cover cloth or to install this equipment in poorly ventilated places.
Overheating could damage this equipment.
» Do not expose this equipment to rain or moisture. Do not touch the power
connection with wet hands
Risk of short circuit, electric shock or fire
» Do not damage the power cord or leave it under pressure
Risk of fire or shock circuit
» Toreduce the risk of electric shock, do not remove the Cover (or Back).
No user-serviceable parts inside. Misusage, improper, and negligence could
damage this equipment. Need to refer servicing to qualified service personnel.
» Do not continue to operate if there appears to be fault.
If the unit ceases to function, contact qualified service personnel for help.
» All work related to the installation of this product should be made by qualified

service personnel or system installers.

Liability

PiXORD Corporation reserves the right to make corrections, modifications, enhancements,
improvements, and other changes to its products and services at any time and to discontinue
any product or service without notice. Customers should obtain the latest relevant information

before placing orders and should verify that such information is current and complete. All



products are sold subject to PiXORD Corporation’s terms and conditions of sale supplied at

the time of order acknowledgment.

PiXORD is not responsible or liable for the resale of its products with statements different from
or beyond the specification/parameters stated by PiXORD. Customers are responsible for their
applications using PiXORD products. To minimize the risks associated with customer
applications, customers should provide adequate operating safeguards. PiXORD is under no
obligation to provide any further technical support service or product/software alteration

beyond PiXORD's representation.

PiXORD products are not authorized for use in safety-critical applications where a failure of the
PiXORD product would cause severe personal injury or death, unless officers of the parties

have executed an agreement specifically governing such use.

Reproduction of PiXORD information or datasheets with alteration is an unfair and deceptive

business practice. PiXORD is not responsible or liable for any such statements.

Every care has been taken of this manual. If there are any inaccuracies or omissions, please
inform your local office. PIXORD Corporation cannot be held responsible for any typographical
or technical errors. PiXORD Corporation is not liable or responsible for incidental or damages

caused by mishandling.

Trademarks
All names used in this manual for hardware and software are probably registered trademarks
of respective companies. PiXORD is a registered trademark of PiXORD Corporation. All rights

reserved.

Support

If you require any technical assistance, please contact your PiXORD reseller. You can connect
to the Internet PiXORD’s website: www.pixord.com for below information,

® Download user documentation and firmware updates at PiXORD Support

( http://www.pixord.com/support/support.asp)

Find answers to resolved problems in the FAQ database. Or contact our FAE at technical

support (http://www.pixord.com/contact2.asp)



http://www.pixord.com/contact2.asp

Introduction

PiXORD PD614 Series Network Camera delivers superior H.264-AVC performance, state
of the art design and function. PD614 Series is specifically adapted for maximum
performance indoor applications, such as commercial, banking, government buildings,

schools, universities and airports.

H.264-AVC video compression can lower bandwidth and storage requirements without
compromising image quality; Motion JPEG is supported for increased flexibility, as well as

multiple independent video streaming.

PD614 value-added features include; on-board video motion detection, two-way audio,
Micro SD card storage and PoE model is available with full PoE (IEEE-802.3af) feature that
supplies function of power to the camera via the network, eliminating the need for power
cables, reducing installation costs and complexity. Consequently, PD614 is “Best in Class”
for maximum performance IP video surveillance systems, demanding superior image

quality, ease of installation, and intelligent video capabilities.



Installation

1. Hardware

Audio Out (Green)

Audio In (Pink)

Power

LAN Port




2. Software Installation

The following software is necessary for the proper display and use of the P600 from the Web

site. The software will be available from the Software Package CD.

IP Installer

The IP Installer is used to locate and configure network cameras and video servers on
the LAN. This utility is useful for conveniently configuring the network settings of the
device, or for finding a device once the network settings have been modified. To install
the IP Installer, from the Software Package CD UlI, select IP installer, then follow the on

screen instructions.

VLC
Though not necessary, this can be used for viewing the streaming without a Web

browser.



3. Network Configuration

IP Installer is a utility that provides an easier, more efficient way to configure the IP
address and network settings of the devices. It even provides a convenient way to set the
network settings for multiple devices simultaneously using the batch setting function.
Moreover, IP Installer can save the network settings for all devices as a backup and

restore them when necessary. NOTE: Default mode is DHCP.

Preparation before IP Assignment

1.  Always consult your network administrator before assigning an IP address to your server
in order to avoid using a previously assigned IP address.

2. Ensure the device is powered on and correctly connected to the network.

3. MAC Address: Each device has a unique Ethernet address (MAC address) shown on the

label of the device as the serial number (S/N) with 12 digits (e.g. 000429-XXXXXX).

M/N:POF0512E030001

DI

*0004290000

4.  Although the IP Installer is able to find and configure any Pixord devices on the LAN
except those that are behind a router, it is a good idea to set the host PC to the same
subnet. In order to connect to the Web-based user interface of the camera, the host PC
must be in the same subnet. For more information about subnets, please consult your

network administrator.

Using IP Installer to Assign an IP Address to PD614

1. Once IP Installer has been successfully installed on the PC, double click the IP Installer
icon on the desktop, or select it from Start > Programs > Pixord > Device Search > IP

Installer.



2. Click the menu bar Tool > Search Network Device to search the device in the LAN.

EEX

w | Untitled - IPInstaller
File Edit View Sl

Ctrl+F

Search Network Device

| Subnet Mask. | Gakeway DMS1

4

Serach All Network Device

|a

3. From the list, select the device with the MAC Address that corresponds to the device that
is to be configured. The MAC Address is identical to the unit’'s S/N (Serial Number).
4.  Double click the item to open the Property Page for the selected device or click the menu

bar View > Property.

7 Dntifled - IPInstaller

File Edit BGTYS Tool Help
9 = [ v Ioolbar 7
State | ] ¥ SfefusBer ddress [IP Address | SubmetMask | Gateway | DNs1 |

O ] 20-01-%e-ff 192168287 2552553550 192168235 16809511
O ]ﬁ 20-01-a2-ff 1921682105 2552553550 192188321 1629511
O ] Def. UserPass... 20-01-08-ff 1921682155 2552553550 1921682354 16809511
O 1 +29-00-h4-ff 192168288 2552553550 1921682354 16809511
O Faa0 00-04-29-01-05-£f 19216828 25532552550 1921682254 16858511
O Po0D 00-04-29-01-0b-ff 921658239 2553553550 19216832254 1689511

5.  Afterfilling in the properties, click [Set] button to complete the configuration settings in

the remote device while saving configuration in the PC.



Firtrware Version

1.0.2_rc11

Froperty

IF Address 192 .168. 2 . 42

Subnet Mask lm
Gateway 192 .168. 2 .254
Hitp Port IT
DMS1 168.95 .1 .1

DMNS2 168.9 .1 .1

DNE3 168.9 .1 .1

Usermame & Password

[ Use Custom

Usemame |

Password |

Open the Web-based Ul of the selected camera

1. To access the Web-based Ul of the selected unit, run the View > Open Web on the menu
bar.

2. If the device has been configured correctly, the default Web browser will open to the
home page of the selected device.

3. If you find your browser is opened and automatically connected to the camera Home
Page, it means you’ve assigned an IP Address to the unit successfully. Now you can

close the IP Installer and start using your camera.

Verify and Complete the Installation from Your Browser

When browsing the Home Page for the first time with the Microsoft Internet ExplorerTM, you

must temporarily lower your security settings to perform a one-time-only installation of the

ActiveX component onto your workstation, as described below:

1. From the Tools menu, select [Internet Options]

2. Click the [Security] tab and then click [Custom Level] button to see your current security
settings.

3.  Setthe security level to Low and click [OK].

4.  Type the URL or IP address of your camera into the Address field.

5.  Adialog box will pop up asking if the ActiveX control should be installed. Click [Yes] to

start the installation.

10



(2 Live Yiew - Windows Internet Explorer \ZIIEHZ\

@v i) hitp:192.168.1 1160viswiview il 2 [3][x] [Live searen 2]~

— »

w FYEEE R N
G E AR ERE TR TS Poo Comorian 8 v IRANE AR  MENERE » ks —
PiX@RD i — p— 2003.08.04

5

@ IRISIRRETE ActiveX IZHTE: SR8 'Pixord Corporation’ & pixord

< | &

Once the ActiveX installation is complete, return the security settings to their original value, as

noted above.
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Access to the Camera

Following the successful installation and IP assignment, PD614 camera will be able to be
accessed. The intention of accessing to the camera is most likely for the live video images;
there are various configurations as well. It works with most Windows system and Browsers.
The most recommended browser is Microsoft Internet Explorer (7.0 or above). Other browsers,
like Mozilla Firefox, Apple Safari and Netscape Navigator, are functionalities/configurations
partially supported, while live video can work on those platforms where VLC must be installed

as the video codec.

Note: With Internet Explorer of the access, the installation of ActiveX control is required as
described in the previous section.
The Live View Page

The first view of logging into the camera web is the live video images with information

including camera IP address, video format / resolution / frame rate / bit rate and system date.

IP: 192.168.2.85 1600¥1200 12 FPS 2835 K bps 2005-10-06

The Quick Function Buttons come with the video panel for immediate functions or taking

effect.

l._EJ Full screen: enlarge the video image to the current screen size.
lDJ Listen: the audio sent from camera

9 -

L Talk: the audio sent to camera

l_!J Record: record current live video images in “.avi’ format

l-_g Snapshot: Capture a still live image in JPEG format

12



Further configurations and options; a prominent button in between is used to expand the
further operations. Not all buttons of function are described below. Options appear when

specified in the configuration page.

IF; 192, 0 602,05 HEZGd 1am0x 200 12 FPS 1972 E bp:

e

EIGICNONCTE

IP: 192.168.2.85 H264 1600X1200 14 FPS 1751 K bps

IMAGE SETUP MANUAL TRIGGER VIDEO STREAM

M| Actual Size v

SETUP: Further configurations and functions

LANGUAGE: Language selection for the Web Interface.

IMAGE SETUP: An actual size check box. Default is unselected, which Image frame is scaled
down or enlarged to fit the web VGA size.

MANUAL TRIGGER: Applied as one of the trigger conditions, see Event Handling for detail.
VIDEO STREAM: Select the current displayed stream.

13



Video and Image Configuration

This section describes how to configure the video streaming from the device, and the related
camera image configurations. Users with Administrator or Operator (see Users Settings)

authority are intended for these configurations.

".: ity
-

Click on |- button to enter in the configuration pages.

Video

There are 3 tabs,
- General
- Advanced

- External Video Source

14



General

General Advanced External ¥ideo Source

¥ideo General Setting
M Enable Stream 1
¥ Enable Stream 2

¥ Enabled Digital PTZ

¥ Enzble Stream 3

0OSD Setting

V¥ Enable

¥ camera Name: ICHl [20 character max)

F Datef/Time

Video General Setting
The list of video streams is provided for enable/disable selection. Stream1 is default enabled

(selected). Maximum 3 streams can be concurrently enabled for different client requests.
Digital PTZ: This function is available in stream2.

OSD Setting

Enable the On Screen Display (OSD) information. A line of text message (e.g. Camera Name

or Position) and the date/time string are available to be selected for displaying or hiding on the
images.

15



Advanced
The Video Advanced setting page provides more detail stream configurations. These settings

can affect video size, quality. The expected transferring performance must be under the

condition of full network bandwidth

—
General Advanced External ¥ideo Source

Stream 1 Setting

RTSP Path: woo Irmage Format: IH.264 vl
Resolution: 1600 x 1200 'I GOP: ISD (1~150)
video Mode: CBR vl Frame Rates: |15 (5~15 FPS)

Target Bit Rates: [3000 (64~&000 Kb)

Stream 2 Setting

RTSF Path: vl Irmage Format: IMJPEG 'I
Resalution: €40 x 480 vl GOP: ISU (1~150)
video Mode: WBR vl Frarne Ratas: |15 (S~15 FPE)

Guality Levels Best - |

Stream 3 Setting

RTSP Path: w0z Irnage Format: [H.264 <]
Resolution: 320x240 GOP: 30
video Mode: WER Frarme Rates: |15— (5~15 FPS)
Quality Level: Standard

RTSP Path -

The RTSP Path is the stream ID used for RTSP client streaming connection, such as VLC
player. The default values are v00, vO1 and vO02 for the three streams respectively. The string

can be any combination of number or capital/small letters. It can not be empty however.

Resolution -

The resolution here describes an image size counted by width and height, e.g. 640x480,
referring to pixel resolution. The 1% stream can be set from more options of resolution;
1600x1200 (2 megapixels), 1280x720(HD), 800x600(SVGA), 640x480(VGA),
320x240(QVGA). While Stream2 has the options of VGA and QVGA, stream3 is in a fixed
resolution, the QVGA.

Video Mode -

This option allows the selection of two bit rate modes, the Constant Bit Rate (CBR) or Variable
Bit Rate (VBR). CBR refers to the setting of a fixed Target Bit Rate (configuration in the rage
of 64Kbps to 6Mbps) that would apply in the case of limited bandwidth or/and storage
requirement. While CBR concerns a fixed data rate transmitting, the video quality is of high

priority for VBR mode selected. VBR therefore is configured with the Quality Level (Standard,

16



Good, Best). In general, CBR predicts the provided condition; if image activity requires higher
bit rates than configured, the frame rate and quality would be affected as not likely to increase
bandwidth (bit rate). In spite of the required recording storage estimation, VBR is by way of

compensation that adjustable bit rate fits the actual image activity.

Image Format -

H.264 and MJPEG are available for image format selection. The term, “image format”, is
referring to compression / encoding technique. The selection of image format decides the
performance of bandwidth and storage requirement. In the request of same video quality,
H.264 contributes to less bandwidth and storage requirement, which is more efficient than
MJIPEG.

GOP -

In MPEG4/H.264 video coding, GOP (group of pictures) describes how the different types of
frames are arranged. The frame types implemented here are I-frame (full image information)
and P-frame (motion-compensated difference information). This setting configures the GOP
length which is the number of frames before next I-frame appears. Having more I-frames

usually increases the stream size, and therefore more bandwidth and storage are required.

Frame Rates -
The Frame Rates defines the number of frames that will be displayed per second. The frame

rate setting can affect the target bit rate (bandwidth requirement) and storage requirement.
Note:

While multiple streaming is possible, each stream has its limitation and dependency to other

stream. See “Video Stream Specification”.

17



External Video Source

General | Advanced External ¥ideo Source

External ¥ideo Source List

Hame IP address

( Mote: The maximum number of external video sources is 10, )

External Yideo Source Setup

Marne: MewWideoSaurce

IP address: 0.0.0,0

Video Port: 554

Product Type: | FiPEO0/E05/606/607/614/615/616/617/621/623/625 |1]
Video Format:

Resolution:

Rotation: m

Audie Enable: [ off [v]

RTSP Path: woo

This page is provided to configure and keep other video links (from specified Pixord video
models) that will be applied in the web access of the current camera unit, for instance, the

application of video conference.

To add an external video link, click “Add...” to show the configurations. The “Product Type:”
lists the models that are applicable in this function. While the proper configuration is done, click

“Connect” to test the existence of destination server and preview the images.

Test Video:

18



Video Conference

When “External Video Source” is configured with at least one link, the video conference button

can be found on the live view page.

IP: 10.0.0.37 H264 1600X1200 6 FPS

N

SETUP | LANGUAGE IMAGE SETUP , VIDEO STREAM
W Actual Size o122

Press the button, the Video Conference will then be presented as below; the local video is

showing left hand side, while right panel is displaying remote site video images.

Video Conference ﬁj i:d |

Remote
Camera: [ NewVideoSource E] m‘

19



Camera

This page provides the basic image color appearance and further image settings.

General Advanced

Camera General Setting

Brightness: e | m 7137_7
Hue: K1/ ] 1[0] o
Saturation: [«E 1 m [o

[J Rrotation 120

Audio Setting

[ Audio Enable

Web Record Setting

Save Path:

File Mame:

Browse

Web Snapshot Image Setting

Save Path:

File Mame:

Browse

General

Brightness: the luminance of image view

Hue: refer to pure a pure color, or described by its name, such as red, green or blue.
Saturation: intensity of a specific color

The 3 correlates are referring image appearance in terms of color/vision. These are adjustable

from this page.

Rotation: rotate the image, so it looks up-side down. This can be applied when camera unit

must be ceiling mounted and the image is therefore reversed.

20



Audio: enable this option, so the video stream will be transferring accompanied with the audio
data.

Web Record / Snapshot: define the location where snapshot images and video clips will be
stored. The file name is referring to the prefix of the actual file name of each snapshot image or

video clip generated.

Camera Advanced Setting:

white balance: Auto hd

Exposure: Flicker-free 50 Hz %

Max Expasure Tirme: 1730 % | =

Max Gain Control: 21 ¥ | dp

Status LED: Cn W
Advanced

White balance: the adjustment to compensate for different environments in terms of light
source.

Exposure: Anti-flicker setting for image sensor to fit the frequency of light (power) source. For
instance, the power frequency is 50Hz for most European countries, while 60Hz is typically for
US. This setting is therefore regionally different. Note: Default setting is 50Hz

Max. Exposure Time: referring to the shutter speed.

Max. Gain Control: the amplification factor for the incoming light.

Status LED: Turn ON/OFF the status LED.

21



Event Handling

Event Handling describes the configurations of event type and the corresponding actions. To
have an insight into this function, a common example can be storing a captured image to a

local storage or remote FTP server (Actions), when there is a Motion Event (Trigger Condition)

Event Server

Event Server Maotion Detection Event Configuration

Event Server List

Hame Protocol Hetwork Address Upload Path  User Hame

| AddFTP.. || Remove

[ Mote: The masimum number of event servers iz 10,

The “Event Server List” lists the configured server(s) that will act as a remote storage or a
destination for handling the triggered event. Currently, FTP is the only available server type.

Up to 10 FTP servers can be added in the list.

22



Motion Detection
A snapshot image shows the whole view of the camera covered. To select a motion detection
area, click directly on the image, then change the size and position by dragging and drawing.

Up to 10 motion areas (configurations) can be added in the list. Each detection area can be set

with its own sensitivity value.

Event Server Motion Detection Event Configuration

Motion Detection List

Vindows Area Hame

( Mote: The maximurm number of motion detections iz 10,

23



Event Configuration
The Event Configuration is to assign the actions responding to the specified events (Trigger

Conditions).

Event Server Motion Detection Event Configuration

Event Record File
File Forrmat: & spea O Hzes
Event Type List

Hame Status Enahle Trigger Actions

Add... Remove

[ Mote: The raxirnum nurmber of events is 10,
Fu=FTP Uplaad, Eu=Ermail Upload, Du=Disk Upload, ©=0Cutput Port, En=Ernail Motification,

Trn=TCP Motification, )

The table lists the configured events. Click on “Add...” or choose an event from the list to

expend the panel for detail configurations. “Remove” is to delete a selected event.

Event Server Motion Detection Event Configuration

Event Record File
File Format: & 1pea O Hzes
Event Type List

Hame Status Enable Trigger hctions

Add... Remove

[ Mote: The maximum number of events is 10,
Fu=FTP Upload, Eu=Ermail Upload, Du=Cisk Upload, O=0Cutput Port, En=Email Motification,

Tr=TCP Motification, )
Event Type Setup

Marne: MewEvent

Set min time between triggers: 00:00:00 [rmax 23:59:59)
Respond to Trigger

@Always

O Curing time between

Sun Mon Tue Wed Thu Fri Sat
Start Time : (max 235059
Cruration : (max 165:00:00)
ONeuer
Trigger by b

When Triggered...
I:l Upload Images

[ send Ernail Hotification

24



Trigger types (conditions)

Motion Detection: The configured detection area(s) for motion events.

Manual Trigger: a virtual trigger button embedded on the web main page.

When triggered” Actions

Store image to FTP (Remote) / Micro SD Storage (Local)

Send Email Notification

Event Schedule
Events may come frequently, for instance, a moving object keeps triggering as being in a
detection area. False alarms can therefore occur. The “minimum time between triggers”

setting is then for this case. System waits for the given time before the next trigger taken.

By default, each configured event is always effective. It can also be scheduled by selecting

start day/time and the duration of effective.

25



Local Storage and Schedule Recording

PD614 is equipped with a card slot for storage. This storage is applied for local video recording.
The recording function can be launched according to schedule. The micro-SD card also

records the JPEG images responding to an event.

General

Define the day (specified by days of a week) and time (specified by each single hour) for that
will be recording during the scheduled period. User can select which video stream should be
recorded, and the size of each sliced file. When the check box is ticked, recording process

starts at the scheduled hours (red blocks).

General Storage
MEnabled
strearm: W1 Oz O
Slice File Size: (me)
Save Device Type: Local Disk
B stecuies

Storage
Display the storage information, includes disk size info, type and status. The warning message
(red text) shows when recording is on process; Micro-SD card should not be removed during

the recording process.

General Storage

Disk Status
Model Hame: fdewrmrncblkopl
Total Size! 1925500 KB
Used Size: 1838892 KB
Frae Size: 26502 KB
Disk Type: S0
Disk Status; recording

Refresh | | Browse | | Remove Event Images
The system is recording now, please stop recording first!

26



The “Browse” button allows viewing the list of recorded files. The web page will then be
redirect to the root path of the SD storage (if one is inserted). The list includes couple of folders,
the Oevent_images which contains all the still images captured by any event trigger, and
folders specified by date where the recorded video files are located.

& Network Camera - Windows Internet Explorer

@E} v || hepyitz.tee.2.85 ] (4] [x

File | Edit View Favorites Tools  Help

5} E [ @Netwurk Camera ]_l

Index of /SD/

Hame Last modified Size Description

a Parent Director

| Oevent_images/ 04-Feb-2010 10:13 460K
| 2009-12-14/ 14-Dec-2009 17:13 4K
] 2010-02-04/ 04-Feb-2010 10:10 4K

Mbedthis Appweb 2.4.2 at Port 80

The recorded files are named in date_time format, and the extension file name is “.h264”.

While file is in h264 raw format, it can be played in VLC player. Note that the recorded file
includes video only; no audio information is recorded.

& Network Camera - Windows Internet Explorer

@E} v || hepyitz.tee.2.85 ] [#2)[x
File Edit View Favorites Tools Help
5} e [ @Netwurk Camera ] l @ 1

Index of /SD/2010-02-04/09/

Hame Last modified dlze Description

a Parent Director

2010-02-04 09-41-58 . h2Ad4 04-Feh-2010 09:43 7.10

2010-02-04  09-57-06.h264 04-Feb-2010 10:064 S0M

Mbedthis Appweh 2.4.2 2t Fort 80
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Network Configuration

IP Camera acts as one of the network devices. It is therefore allowed “IP” to be assigned, so
certain network functionalities can be implementable within this device. This section describes
these configurations. Fundamentally, for instance, the IP assignment of the device can be
done via DHCP server, manually fixed IP option or PPPoE to obtain IP from service

provider.

General
Device IP configuration, includes DHCP, Static IP setting and PPPoE. “Enable ARP/Ping”
enable device to accept ARP or ping packets from the network. Disable this option may

provide extra security from intentional ping.

General Advanced SMTP{E-Mail} DDNS

) DHCP Service

O Static IP Address:
IP Address:
Metrnash:

Gataway:

DMS 1 168.95.1.1
DHS 2: 168.95.1.1
O PPPoE:

User Hame:
Password:
(Mote : Please make sure 'Email Setting' has been set!)

[#] Ensble ARP/Ping

Save

28



Advanced

——
General Advanced SMTP{E-Mail) DDNS

NTP Configuration
O Obtain NTP server address via DHCP
@) Use the following NTP server address:
Network address: tirne, stdtirme, gov.tw

(host name or IP address)

HTTP Setting

HTTP Port: 20

RTSP Setting

RTSP Port: 954

HTTPS Setting

[ enable HTTPS

Bonjour Setting

Enable Bonjour

UPnP Notification

Enable UPRP

NAT Traversal Setting
Enable MAT Trawversal
MAT-T HTTP Port: a00n
MAT-T RTSP Port: s002

MAT-T RTSP Protocol:  TCP

Enable or configure other network functions.

NTP: Configure a NTP (Network Time Protocol) server, so that the device system date and
time can be synchronized with a specified Time Server. This configuration is provided for one
of the potions of system date/time adjustment.

HTTP: set the HTTP port that will be applied for Web Ul access.

RTSP: set the RTSP (Video) port for video data transmission.

HTTPS: Enable/Disable Http security function.

Bonjour: Enable Bonjour service, so that the device can be discovered with “Bonjour” service
applied.

UPNnP: Enable UPnP, so that the device can be discovered in an UPnP Compliant Network.
NAT Traversal: Enable NAT traversal, so that client from Internet can have access to the
devices behind the Router.

Note: with UPnP enabled, the IP Sharing device (Router) capable of UPnP function will

automatically be noticed with the device’s NAT port.

29



SMTP(E-Mail)
Configure an email host in the device that will send email on behalf of the configured email
account in a circumstance like sending an email notice to a specified mail address (Event

Configuration).

Sender: Complete the Mail Server, Server Port, Authentication information (if required) and
the sender’s email address.

Receiver: The receiver email address

General Advanced SMTP{E-Mail) DDNS

SMTP (email) Setting
Mail Server: smtphost.yourdomain, narme
(host name or IP address)
Server Port: 25 [0..65535]
[ authentication
User Mare: username
Password: sasssass
From [ Email Address ): username@yourdomain.name

Send email to: rnailto@rmailto, com

Test

Save

DDNS
Dynamic DNS configuration; the network device can be assigned and accessed with a host

name instead of IP address by registering this service (Internet access required).

Host Name: Assigned name that will be used for access to the device
User Name/Password: Account authentication for logging to this service
Update Time: Periodically, the device updates its access info to sever in the configured time.

Response: the device responds the connection info.

General Advanced SMTP{E-Mail) DDNS

Dynamic DNS Setting
[ oons enable
Host Marne: hostname
(Link to_http://www.dyndns.org)
Uzer Marme: username
Password: sssssnss
Update Time: &00 [ 600~86400 Seconds )

Response: no

Save
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System Options

Information

Lists of System and Network configurations

Information User Date & Time Server Maintenance Log Service
System
Maodel: PD614
Systern up tirme! 2000-01-30 01:48:34
Firrmware verzion: 1.2.4_210
MAC Address: 00:40:ab:cd:ab:ac
Activer Control version: 1.0.1.134
Ethernet
Status: Connected
Maode: Static
IP Addrezs: 192.168.2.156
Metrnask: 255.255.255.0
Default Gateway: 192.16%.2.254
PPPoOE
Status: Mo connection
IP Address: none
DNS Server
Primary DHS IP address: 168.95.1.1
Secondary DNS IP address: 168.95.1.1
DDNS
Status: no

User
Login users for Web access and operations; authentication required. The Check box is for
anonymous logging on to the live view page. Logging for further configurations will still require

user name and password.

Information User Date & Time Server Maintenance Log Service

User Setting

Ensble anonymous login (no user name o password required)

User List
User Hame User Group
aduin Administrator

Add... Remove

Save
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Date & Time

System date/time configuration. Options of synchronizing with PC and NTP server are
provided for automatic adjustment.

Information | User Date & Time

Server Maintenance Log Seryice

Current Server Time

Data: Tirne:

Set Server Time

[#] sustarnstically adjust for daylight saving time changes.

Tirme Mode:

O syrchronize with cormputer tirme

Date: Tirne:
O synchronize with NIP server
Tirne zone:
G)Set Manually
Date: 2010-02-03 Tirne: 18:04:07
(ex: 2008-01-01) (ex: 01:00:00)
Save
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Server Maintenance
This page provides tools for system maintenance; Reboot and Load default settings, as well as

functionalities of launching upgrade process, backup/restore user settings and language

defines.
Information ‘ User Date & Time Server Maintenance Log Service
Maintain Server
Reboot Load default
Firmware Upgrade
Model: PD614
Firmware Wersion: 1.2.4_210
MAC Address: 00:40:ab:cd:al:ac
Activel Version:. 1.0.1.134
Specify the firmware to upgrade:
Upgrade
Backup
Save all parameters and user-defined scripts to a backup file, Backup
Upload Setting
Use a saved backup file to return the unit to a previous configuration,
Specify the backup file to use:
Upload
Add Language
Choose language: | AFEE hd
Get a language file from glangg en/ Iang.is
Select language file to upload:
Upload Language
Log Service

Most system operations and / or process will be kept in a log system. The link provides the

review of these records.

Date & Time Server Maintenance Log Seryice

Information | User

Reports

Server Report Parameter List
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Web Interface Customization

This page provides the function of adjusting the look of live view page. There are two types of
layout settings; use default look or use custom settings.

Live Yiew | Yideo Metwork | System Customize

Camera Event ‘ Schedule

Live Yiew Layout Setting

(&) Use Default Lock (O Use Custorn Settings
User Defined Links

[ show custom Link 1

Marne: Custorn Link 0 URL: http:/d

[ show custom Link 2

Marne: |Customn Link 1 URL: http:fi

O show custom Link 3

Marne: |Customn Link 2 URL: http:fi
O show custom Link 4

Marme: [Custom Link 3 URL:  http:fs

Save

Use Default Look: the default layout of live/configuration pages

Use Defined Links: Web link(s) will be presented on the live page when enabled. It can be a
link to another IP camera for instance, or other preferred web link.
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Use Custom Settings: The modifications allowed are change of Background / Text Color,

Background picture, Title, Description, Logo and etc.

Live Yiew Layout Setting

O Use Default Look ® Use Custarn Settings
User Defined Links
O shaw custam Link 1
Marne: |Custorn Link 0
O shaw custam Link 2
Marne: |Custorn Link 1

URL: |http:ff

DShow Custorn Link 2

Narne: Custorn Link 2 URL: http:ifd

O show custorn Link 4

Narme: Custorn Link URL: http:ifd
Custom Settings
Modify the Default Laok:
Backaround Colar: @Default Qown: wihite | W
Text Color: @ pefault O own: | Black [+

Background picture: @Nor\e

O Externali httpsss

Title: ® none O Dafault
O own | Title
Description: @None QDeFault

O own: [Description

Logo Link: @None QDeFault
O own: |httpsdf
Logo: O Mane @ Default

O External: |httpsss

O own

Select image file to upload:
Upload
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Troubleshooting

Check firmware version

The version code can be found in Setup -> System -> Information, or simply type

“version.html” after the URL address, e.g. http://192.168.0.200/version.html. Firmware version

indicates the functionalities’ updates or availability in the camera system. Therefore, in the first

step of troubleshooting and then reporting, it helps to locate the found issues. Newer version

firmware may have corrected the current bugs.

| —
Live View ‘ Video ‘ Camera Event ‘ Schedule Network System
Information User Date & Time ‘ Server Maintenance Log
System
Madel: PD614

Systern up times 2000-01- 102:36
Firrnware u( 1.2.4_ZTIJZHJ>
/~ loading - Windows Internet Explozer

@ _:_-: - |g, hitp:#192.168.2.1 56 erson hitml
£ - | EPdEE .. | = |v| | | - l{} - v
T pdfforge | - | Search

wir 4R [@hading

‘ 1.2.4 210
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Upgrade device firmware

Firmware upgrade process should be done via the web configuration; Setup -> Server

Maintenance -> Firmware Upgrade. Before the process, read the instructions and release

notes coming with each new released version. For the steps,

1.
2.

Check and retrieve the latest firmware bin file.

Disconnect all clients (e.g. streaming requests) to the device that will be firmware
upgrading.

Stop the local (schedule) recording if it was enabled.

Go to the Firmware Upgrade page, browse and locate the downloaded firmware bin file,

then click on “Upgrade” button.

Firmware Upgrade

Madel: P&OD

Firrnware Version: 1.0.3_rc

MAC Address: 00:04:29:01:a0:FF
Activer Wersion:. 1.0.1.132

Spacify the firmware to upgrade

CivDocurnents and Settings\PCADesktophH, 21 Upgrade

The upgrade should start in minutes, depending on file transferring status. The web will
then be directed to the system writing progress. Overall upgrading process takes about
5~10 minutes. In this period, DO NOT DISCONECT the power. System of the unit can be

damaged otherwise.

Firmware Upgrade

Tt is strongly recommended to stop any unnecessary jobs while updating firmware.
Please be patient and the updating process may take a long time.
Please waiting about two or three mimutes!

Writing Progress:

36 %

The power LED (orange one) will be quick/slow flashing during the upgrading process.
When it becomes again steady on, camera is ready to be accessed. Check the firmware
version. If somehow system is not upgraded, redo above steps. In the case, restore

factory default process may be required.
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Restore Factory Default Settings

In some cases, system does not respond to any operation, this process gets the unit back to

initial status, so that it can be reconfigurable for up and running again.

- =2
- 83
| VTR

,.m -"oe.:u:/ .ﬂh. F_" |

To restore factory default, follow the steps below:

1. Unplug the power jack to turn off the camera

2. Press the button (circle in red) and keep it pressed until instructed to release.

3. Plug in the power jack to turn on the camera. The LED will start flashing in a short
while.

4, Release the button when the LED starts quick flashing. The device should be set

back to factory default.
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Video Streams Specification

The availabilities

1. Each stream can be switched to either H.264 or MJPEG mode.
2.  Each steam can be configured to either CBR or VBR mode.
3. Streaml (main stream) is available from all the resolutions listed.
4.  The maximum resolution setting for Stream2 is 640x480.
5.  Stream3 is fixed in 320x240.
6. The maximum frame rate for transferring 1600x1200 is 15fps. Others can reach up to
30fps.
STREAM1 |STREAM2 |STREAM3
Encoding Mode
H.264 / MIPEG \ \ \
Transferring Mode
CBR/ VBR \ \ \
Resolution @ Max. FPS
1600x1200@ 15 \
1280x720@30 \
800x600@30 \
640x480@30 \ A
320x240@30 \ \ \%
Dependency

1. Max. FPS dependency: when Stream1 is set to 1600x1200, the maximum frame rate is
15fps. Accordingly, both Stream?2 and Steram3 can be configured with the frame rate
from 5 to 15 fps.

2.  Resolution dependency: The maximum resolution of Stream?2 is depending on the
resolution setting of Stream1. When Stream1 is set to 320x240, Stream 2 is limited in
320x240.

3. Frame rate independent: Frame rate setting for each stream can be independent, for
instance, Stream2 can be set 15fps and Stream3 is 30fps while Stream1 (1280x720 or

below) is set to 5fps.
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STREAM2 STREAM3
STREAM1
640x480 | 320x240 [ 320x240 (fixed)
1600x1200, 5~15 1ps 5~15 fps 5~15 fps
1280x720, 5~30 1ps
800x600, 5~30 fps 5~30 fps
5~30 fps

640x480, 5~30 1ps
320x240, 5~30 1ps 5~30 fps

Note the resolution setting must follow the sequence: Streaml = Stream2 = Stream3.
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